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Introduction of new features of
Flux 2019.1 1

This chapter covers the following:

e 1.1 New features of Flux 2019.1 (p. 5)
e 1.2 New features dealing with the documentation of Flux 2019.1 (p. 15)
e 1.3 New features dealing with the macros of Flux 2019.1 (p. 17)

Introduction
This chapter presents a list of the main new features of Flux 2019.1

The main new features are listed and the chapter references are given, where the necessary
information for a good usage of the new software capabilities is presented in detail.

To localize the impact of the various new features, the flowchart of Flux software principle is presented
below.
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1.1 New features of Flux 2019.1

New features dealing with Physics

New features Description

Magnet Flux 2019.1 offers the capability to take magnet demagnetization phenomena
dema_xgnetiza_tion into account during solving process for 2D and 3D transient applications,
during solving  ,,5 empowering the modelling of devices like rotating electrical machines.
process For example, computation of typical quantities such as motor torque or
electromotive force are now more accurate and new analysis like the evolution of
the remanent flux density on magnets are available.

This feature, based on a static Preisach model implemented in the Flux solver,
applies to permanent magnets described by non-linear materials defined by their
coercive force Hc and their remanence Br.

Demagnetization model

B(T)
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Figure 1: B(H) curve showing demagnetization
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New features Description
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Figure 2: Colour shades of remanent flux density on a magnet

To make demagnetization possible during solving process, the model for
permanent “Nonlinear magnets described by Hc and Br module” has been
upgraded with Flux 2019.1, to have a closed-loop B(H) characteristic, which is
necessary to compute demagnetization phenomena. The previous and the new
models are compared in the picture below.

Upgrade of
one non-linear
magnet model

In case you have a Flux project solved with a previous version of the software,
you are invited to delete results and solve the project again to take benefit of
this enhanced model.
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New features Description

p.7

Multi-parametric In addition to already-available iron losses computations on regions and points,
computation Flux 2019.1 adds the ability to calculate these losses for multi-parametric

of iron losses scenarios with a single click.

Results of this computation, which applies to laminated regions for both Bertotti
and LS models, are gathered and stored in a dedicated I/O parameter, whose

values can be easily displayed by plotting 2D or 3D curves and also exported as
row data tables. Creation of efficiency maps, as well as definition of optimization

process are now more straightforward than ever.

At the same time, the dialog box for running all these iron losses computations

was refactored to make it more user-friendly

@' I[ron losses computation

- Computation fype

|ru1ultiparametri|:: an regions

Definition |, Results |

Laminated face regions

-Intervals of parameters

¥ chaice Parameter name Current value Limnit mir Limit max
ID_PILOT ¢ -250.0 (¢ 0.0
IQ_PILOT v 0.0 ¢ 250.0
SPEED ¥ 545.455 & G000.0
AMNGPOS_ROTOR ¢ 44997 |¢f 39.997

-Part of cycle described by the time interval

|Fu|| cycle

-Maodel far losses

|Mnde| defined in material
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New features dealing with Solving

New features Description

Simplification of With Flux 2019.1, the Nonlinear system solver options tab has been
"Nonlinear system simplified. In Standard mode, the user has only to choose between 4 types of
solvers"solving method for computing the relaxation factor for Newton-Raphson before solving:
options e Automatically specified method

¢ Maximal factor method
o Optimal method (computation)

o Optimal method with a stabilization stage

© Edit Solving process options[SOLVING_OPTIONS] =

Thermal\ﬁd«anced\
Lingar system solver * Nenlinear system solvers \ Thermal coupling \
- Parameters for the Newton-Raphson algorithm
Accuracy threshold for Newton-Raphson *
|1.0E-4 |
Maximum number of iterations for Newton-Raphson *
1100 |
During a transient solving, if the maximum number of iterations is reached: *
|St0p the transient solving and solve the other possible transient solvings v|
Method for computing the relaxation factor for Newton-Raphson

Automatically specified method -

Maximal factor method

Optimal method (computation)
Optimal method with a stabilization stage

| OK || Apply || Cancel || Detail > |ﬂ| ® ”

By doing this, the options have been standardized. The older solvers used in the
previous version of Flux stay available through the Advanced mode. This mode
can be set using the supervisor.

Solving process options are applicable for all physical applications of Flux 2D, 3D
and Skew.

Simplification
of "Advanced"
solving options

With Flux 2019.1, the Advancedtab has been simplified. The method for
gauge for edge variables choice appears only in 3D, when we could need it.
So now, the method for gauge for edge variables choice doesn’t appear in
2D or Skew.

By doing this, the options have been simplified. The method for gauge for edge
variables stay available through python command.

4 | :
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New features

Speed-up the
computation for
non-meshed coils

Remeshing with A
formulation in 3D

Induction
machine with
a slip modeled
in the AC
state by the A
formulation in 3D

Results preview
Improvement

Proprietary Information of Altair Engineering

Description

With Flux 2019.1, the computation of Hj by Biot-Savart for each non-
meshed coil during the solving was speed-up by refactoring and parallelizing
the code. Therefore, the computation of the flux for the magnetic scalar
potential formulation without circuit was also speed-up.

In Flux 2018.0, we implemented the magnetic vector potential formulation, or
A formulation, for 3D project. This formulation cannot take into account the
movement. Until now, you had to use the magnetic scalar potential formulation,
or ¢ formulation, into your 3D projects with movement.

With Flux 2019.1, you could now use the 3D A formulation for translating
motion, i.e. with compressible mechanical set. To take into the movement in this
case, the idea is to remesh the compressible mechanical set.

This new feature is only available with the MeshGems mesher.

In Flux 2018.0, we implemented the magnetic vector potential formulation, or
A formulation, for 3D project. This formulation could not take into account the
slip of the 3D induction machine in the AC state. Until now, you had to use the
magnetic scalar potential formulation, or ¢ formulation, into your 3D induction
machine in the AC state.

With Flux 2019.1, you can now use the 3D A formulation to model the slip of
induction machine in the AC state.

This new feature is available only without movement of the mechanical sets.

During solving the evolution of predefined quantities and / or quantities defined
by the user are displayed. Quantities which can be displayed during the solving
are:

¢ Predefined quantities of mechanical sets

e I/O parameters

e Real scalar sensors

The user can thus predict the quantities that he wishes to control during the
solving by creating the sensors / parameters necessary beforehand.

Flux 2019.1 improvement: By default all eligible sensors / parameters are
taken into account. If the user does not wish to see them all, the nhames of the
unwanted sensors / parameters must start with the character _.

Example : _Param1l.

7y Altair
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New features dealing with Post-processing

New features

Animation
improvement

H3D export of
Flux results
for augmented
post-processing

Proprietary Information of Altair Engineering

Description

The codec used to generate movies via the Animation in Flux has been updated.

Now the animations are more robust, with a much smaller size but always with
good quality

Two new features are available with Flux 2019.1 to export results in H3D format
to be read by other Altair software, like HyperView, HyperGraph, OptiStruct,
AcuSolve or SimLab.

The first one, presented here, is available via the Flux scenario dialog box and

it is mainly proposed to users willing to take benefit of all the extended post-
processing capabilities offered by HyperView and/or HyperGraph. The selected
quantities are exported for all scenario steps and on the whole computation
domain; the H3D file is generated during the Flux computation, thus allowing
the user to have preview of colour shades, arrows, etc, without waiting the end
of solving. The generation of this H3D file does not yet work with Flux 2019.1 in
case of distributed computations and in case of domain remeshing (e.g. adaptive
time-step, geometric parameters piloted by the scenario).

0 Edit Solving Scenario[SCENARIO_1] e

Mame of the solving scenario * Comment

State of the scenario: & Scenario fully processed [[] Parametric distribution

Control of transient state \ Control of parameters \ Result storage * HyperView export \

File name |Export_To_Hyper\n'iewlh3d

| [

Quantities

Conductivity

Current density
Energy (volume density)
Lorentz force (volume density)

Magnetic field

Magnetic flux density
Permeability

Power (volume density)
Resistivity

ector potential An

Formula

Delete all

Al o || woy || e || ® |

7y Altair
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New features Description

H3D export of
Flux results for
multiphysics
couplings

This second feature related to H3D export has the main goal to make Flux even
more integrated into the multiphysics processes that involve other Altair tools,
like OptiStruct, AcuSolve and Simlab. This H3D export is available only after the
Flux computation is completed and it is accessible via the Import/Export context
for all data collections, in the same manner as the other multiphysics exports
are (Nastran, native OptiStruct, native Acusolve, etc.). The H3D generated file

may contain one quantity only, computed on the user-defined support, on a
user-selected list of scenario-steps.

@ New Export data to HyperView x

Mame *
| Datakxport_1 |

Comment

- Data collection export

|Expnrt data to HyperView v|
Filename *

| Export_From_Fluy 12
Collection to export *

| DATACOLLECTION_1 -

[ | lgnore the mesh motion

"Ignﬂre the mesh mation

Lg QK Cancel

&

4 | :
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New features dealing with Coupling
New features Description

HyperStudy is a multi-disciplinary design exploration, study, and optimization
software for engineers and designers.

It is interesting to couple it with Flux to leverage the HyperStudy approaches
(DOE, Fit, Optimization and Stochastic) for Flux models design exploration and
optimization.

The HyperStudy to Flux connection allows exploring efficiently the design space
of any electromagnetic devices modelled in Flux (motor, actuator, transformer...)

Before this 2019.1 version, The coupling between Flux and HyperStrudy has
been possible via the Got-It component. Starting from Flux 2019.1 it exist in
Flux a dedicated command to generate a coupling component dedicated for
HyperStudy. A xml file has been created and HyperStudy 2019.1 can read it to
achieve a study of otpimisation with Flux.

f = - ™
@ Generate compenent for HyperStudy coupling (for HyperStudy 2019.1 and later) M

Component name *
|Fqu—HST_Comp0nent |

Overwrite component if exist

) yes
® no
Directory to save component
L
Flux - HyperStudy Component scenario
Coupling | -l
Postprocessing python file
L2

Component inputs

—— Available parameters —— Selected parameters —— @

Geometric \ Physical \ RAD1
FI - S0 hd
RAD1
CHX
TGD
RAD3
RADC =

Component outputs
—— Selected parameters —— @
LENGTH_UNIT

RADC il

—— Available parameters
Geometric \t Physical \

Add all

7y Altair
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New features Description

Linux Flux API With Flux 2019.1, we can now use in Linux the same APIs as in Windows to pilot
Flux.

Flux-Activate An enhanced version of the Flux-Activate coupling component is introduced with

co-simulations  Flux 2019.1 and Solid Thinking Activate 2019.2: in the Flux environment the
definition of the coupling component remains the same, however its GUI on the
Activate side was improved:

e to introduce an “"Advanced” tab for Flux memory settings

e and to add in the “Parameters” tab two new options: the "maximum
computation interval” and the “output extrapolation order”. Both are
intended for providing more flexibility to users when they drive Flux by
Activate and for enhancing simulation performance

In particular, the field "maximum computation interval” enables the user to
force a Flux computation even if the input values provided by Activate have not
changed during this interval. In fact, some electromagnetic phenomena may
have modified the Flux output values that it is necessary to send to Activate to
improve the accuracy of the whole co-simulation process.

The option “output extrapolation order” allows Activate to linearly extrapolate
(order set to 1) the Flux outputs for usage as Activate inputs in the next
computation steps, thus guaranteeing better result quality with respect to
previous versions where Activate inputs coming from Flux were never changed
(extrapolation order to set 0).

Floe crorirririiiiiiiiiiiiiiiiiiiiiiiiiiiiiiniiiiiiiniiiiiiiniiiiiiinii @M
Parameters || Advanced
Fuxto Activate input filename ~fasta" =
Reload input file Reload
[ Multiplexed inputs/outputs
MNumber of input ports 1

Inputs
Label

MNumber of output ports 1
COutputs
Label

Minimal input variation (%} to run Fws computations |0.0
Maximum computation interval 0.0
Cutput extrapolation onder 0
Subsampling {Reduced result storage) 1
[] Add one step delay

Apply oK Cancsl

7y Altair
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New features dealing with dedicated tool for e-Machine post-processing

New features Description

Flux e-Machine toolbox is a new application in Flux dedicated for Electric
Machine. This tool permits to compute and postprocess results dedicated for
e-Machine like efficiency maps. It's a first version. It is planned to enrich the
possibilities of postprocessing in future versions.

Altair Flux e-Machine Toolbox B O X
=]
1 TEST
TEST DATA ? PERFORMANCE MAPPING ?  SINE WAVE TEST ?
Test Condition s loverview [ RS m
@ @ 0.8625863 0.8610287 0.8504711 0.8579135 0.8563550 0.8547983 0.8532408 0.8516832 - PARAMETERS.
0.8501256 0.8485680 0.8470104 0.8454528 0.8438952 0.8423377 0.8407801 0.8392225 Rotor Initial Positi d 0.0
Setings Inputs 08376649 0.8361073 0.8345497 0.8329921 0.8314346 0.8298770 0.8283194 0.8267618 otor Initial Position (deg) -
. T Soeed M 0.8252042 0.8236466 0.5220890 08205315 0.8189739 0.8174163 0.8158587 08143011 RotorFos onMIE{(d<e) 0
F I ux e- M a ch ine orque - speed Maps 0.8127435 08111850 0.8096284 08080708 0.8065132 (0.8049556 0.8033980 0.8018404 Rotor Position Max. (deg) 100.0
Efficiency Map Rotor Postion Step (deg) 333
Rotor Speed Min. (rpm) 500.0
Toolbox Efficiency Power e P Rotor Speed Max. (rpm) 75000
@ @ No. Comp. for Speed 2
/ S 1d Min. (&) -205.0
Current Voltage 170881565 1d Max. (4) 5.0
p— | No. Comp. for Id 2
1q Min. (&) 5.0
154881565 Ia Max. (4) 205.0
S073E —
Iron Losses Joule Losses No. Comp. for g N
@ - Maximum Line Current (&) 200.0
aTEN = >,
L BEREE g Maximum Line Voltage (V) 1450.0
Magnetic Losses E ko
z sasren — 2
3 g
S 1os581565 g
e 3161 — £
g <
b= o]
79.881566- 786081 — =
7ss7E =
54581566
72seen =
asmrses e 1

4 | :
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1.2 New features dealing with the documentation
of Flux 2019.1

New features about the user documentation

Starting from the Flux 2019 version, we begin a migration work of the user documentation with the
following aim:

e to be homogeneous with all the online help of the different softwares of HyperWorks™ suite
proposed by Altair

e to offer you more accurate and accessible online help

This transition will be organized on several versions. Temporarily the documentation of new features
and updated features will be published in pdf format and will be accessible by links integrated directly
into the current HTML documentation associated with Altair Flux™ software

New features about examples
As a reminder, all examples are accessible via the Flux supervisor, in the context of Open an example.

New examples Description

FeMT 2D

The Efficiency MAP of electrical motors becomes one of the key
points for the design of electric motor. Indeed, for users of Flux
software, it is interesting to know the optimal operating points

of their electrical machines. And this in order to find directly the
most advantageous areas in terms of efficiency in the torque-speed
envelope characteristics of the machine. The main objective of FeMT
tool is to obtain the efficiency MAP for the electrical motors.

Wireless power

transformer (3D) This model is based on the wireless power transfer demo kit DC2386A
by Linear Technology. It features two different boards for the
transmitter and the receiver: the transmitter coil is circular spiral coil
with reported inductance value of 24 pH, while the receiver coil has
47 WH inductance value. During this example coupling coefficient and
self and mutual inductances of the coils will be calculated. Finally, for a
deeper understanding of the transfer process and in order to improve
it a capacitor will be added in series with the transmitter and receiver
coils and its influence will be analyzed.

7y Altair
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New examples Description

Coupling Flux-Activate Electrical machine are used everywhere and it will be a major issue
on E-mobility motor for sustainable development. Today it's a true challenge to make

an efficient design of an electrical machine which should answer to
several points: the influence of eddy current on the machine works,
how to optimize the machine, what is the best strategy command
in order to manage the energy consumption... all those questions
are crucial points wondering by designers. That's why it is necessary
to know how to model the behavior of an electrical machine with
different levels of modeling in order to simulate a complete system
as a powertrain for electrical car. There are different approaches to
represent the behavior of a Permanent Magnet Synchronous Machine
(PMSM). The first one is an analytical approach with Park model
(classical first approach). The second one is using magneto-static
tables calculated with finite element (software Flux) or FluxMotor,
these model gives a better accuracy. The last model is the co-
simulation between the finite element software in transient mode
and the Activate. The case of co-simulation depending on the type
of the kinematics, there are two cases: with coupled load and
multiphysics position. A comparative study has been made to show
what are the advantages and disadvantages of each method.

7y Altair
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1.3 New features dealing with the macros of Flux
2019.1

List of new macros
New Macros Description

This macro is used to find the rotor angle for t=0s in order to

align it with the magnetic induction generated in the airgap by the
reference phase (e.g., phase A). It is applied to radial synchronous
machines in 2D transient magnetic applications.

Inputs:

e Number of pole pairs

e Current sources corresponding to electrical phases (the first

Find_rotor_angle_2D one becomes the reference phase)
e The rotor mechanical set

e The stator mechanical set

Output:

e New variable (parameter defined by a formula) called POS_INI
which contains the desired initial rotor angle for t=0s (in
degrees)

This macro is used to find the rotor angle for t=0s in order to

align it with the magnetic induction generated in the airgap by the
reference phase (e.g., phase A). It is applied to radial synchronous
machines in skewed transient magnetic applications.

Inputs:

e Number of pole pairs

e Current sources corresponding to electrical phases (the first
Find_rotor_angle_Skew one becomes the reference phase)

e The rotor mechanical set
e The stator mechanical set

Output:

e New variable (parameter defined by a formula) called POS_INI
which contains the desired initial rotor angle for t=0s (in
degrees)

7y Altair
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New Macros

Find_rotor_angle_3D

CreatePark_Iabc_Drivenby_Idq

Proprietary Information of Altair Engineering

Description

This macro is used to find the rotor angle for t=0s in order to

align it with the magnetic induction generated in the airgap by the
reference phase (e.g., phase A). It is applied to radial synchronous
machines in 3D transient magnetic applications.

Inputs:

e Number of pole pairs

e Current sources corresponding to electrical phases (the first
one becomes the reference phase)

e The rotor mechanical set
e The stator mechanical set

Output:

e New variable (parameter defined by a formula) called POS_INI
which contains the desired initial rotor angle for t=0s (in
degrees).

Create Iabc variables driven from Id, Iq variables in order to
compute Torque versus Id and Iq from magnet motors

Entrées:

e Parameter corresponding to I_A

e Parameter corresponding tor I_B

e Parameter corresponding to I_C

¢ Mobile mechanical set

e Number of poles

e Angle for which rotor is aligned with phase a
e Maximum value for Id

e Number of values for Id

e Maximum values for Iq

e Number of values for Iq

e Number of positions for rotor position

Sorties:
e Create ID and IQ parameters

e Create ID_DRIVEN and IQ_DRIVEN I/O parameters driven by
solving scenario

e A solving scenario is created (ready to be solved with
distribution of computation)

7y Altair
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New Macros

ComputeSkewEffectFromCurve

ConvertCSVFileToOMLFile

CreateLookUpTableFromTMProject

Proprietary Information of Altair Engineering

Description

Trouver le couple avec skew.
Entrées:

e Valeur de I'angle du « skew »
e Quantité a calculer
¢ Ensemble mécanique mobile

Sorties:
e Courbes de grandeur avec et sans effet du skew
e Parameétre entrée/sortie

Convert directly CSV file into OML file. The input are recognized.

Input:
e Select CSV file

Output:
e Créer un fichier OML a partir du nom initial (*_res.oml)

Create look up table from TM project of Flux abc and torque versus
Id, Iq and rotor position.

Input:
e Select CSV file

Outputs:
e Créer un fichier OML a partir du nom initial (*_res.oml)

e It will also include more data such as phase resistance, end
winding inductance, electric period and initial rotor position

7y Altair



Detail of new features of Flux
2019.1

This chapter gives more details of each main new features of Flux 2019.1.

This chapter covers the following:

e 2.1 Demagnetization during solving (p. 21)

e 2.2 1Iron Losses (p.24)

e 2.3 Data Export to HyperView and HyperGraph (p. 42)
e 2.4 Flux - HyperStudy Coupling (p. 45)

e 2.5 Flux e-Machine Toolbox (p. 54)
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2.1 Demagnetization during solving

For non linear magnets defined by Nonlinear magnet describes by Hc and Br module, Flux can
take in acccount demagnetization during solving with demagnetization based on a static Preisach model,
wich allows you to be more accurate for results like torque or EMF for permanent magnet synchronous
machine.

Available for 2D and 3D in magnetic transient application
Initialization by static calculation (Application > Transient initialization)
This model does not take in account temperature variations

Demagnetization model

AN

2
25E.08 7 EOE+05 2 EOE+05 2 EOE+05 T EDE+05 1 25E4D8
H (Am)

Figure 3: Demagnetization model

To use this new model with a solved project :

Proprietary Information of Altair Engineering

Destroy results

Go in Application > Transient initialization and select : Initialization by static calculation
Create a new material Nonlinear magnet describes by Hc and Br module

Check the thick Taking in account demagnetization during solving

Assign the material to regions

Go to Physics > Face regions (in 2D) ou Voume regions (in 3D) > Orient material for face /
volume regions

Run the scenario

7y Altair
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p.22

e Create a new isovalues, select magnet and add BrDemag in the formulas field

Example of results : Surface permanent magnets motor 3D

Figure 4: Full device

. I

For a control angle S”Z[ 0; % S 45 3

18

flux density :.

L ERCLIS
¢ mE slAE.
LR
£ me.27e-3

3 258, 6I0E-3
i 3E,33EE-3
T B4 ITE-X
oL ASSE-F
¢ ommp,pacE.n
& B BLIE-R
Y 3ssEZE-3
T omEmsIEE-T
J EEL HIE-F

p.T18E-3

PSI = pif3 Psl = pi/4 PSl = pif6

Figure 5: Br in the magnet

This local effect can bring some effect on global values like torque or EMF.
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With demagnetization

— ithout demagnetization
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Figure 6:E.M.F with and without demagnetization for¥ = %

[/ Note:
e This new level of modeling can increase the computation time and the memory (ram &

disk)
¢ Not available in 3D with the potential vector
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2.2 Iron Losses

Content

This chapter deals with iron losses handling in Flux:

Computation of iron losses

Iron losses model

Iron losses computation on regions

Iron losses multiparametric computation

LS iron losses computation on point (Advanced)
Deprecated version

Proprietary Information of Altair Engineering
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2.2.1 Computation of iron losses

Introduction
Magnetic losses (or iron losses) computation is a subsequent computation, carried out in Flux post-
processor.

This chapter introduces iron losses computation, from modified Bertotti formulas, or with LS model
(Loss Surface).
The power losses in electromechanical devices are mainly of three types:

o the magnetic losses in the magnetic circuits (also called ‘iron losses’)

o the losses by Joule effect in coils (also called ‘copper losses’)

¢ the mechanical losses (mainly by friction in rotating machines)

Losses in magnetic materials:

The power losses in magnetic materials are connected to the phenomena associated with the time
variation of the magnetic field. They are subdivided into hysteresis losses (of microscopic origin) and
Foucault currents losses (of macroscopic origin). In fact, it is eddy current in both cases.

e The hysteresis losses (microscopic Eddy currents) are associated to currents at a small scale. These
currents are the result of local induction variation caused by the magnetic structure in movement
(essentially wall movement).

e The Foucault losses (macroscopic Eddy current), are due to the excitation frequency. They appear
when domain wall displacement increases due to frequency increase.
Magnetic losses and hysteresis cycle:
In practice, magnetic materials are characterized by their hysteresis cycle and the magnetic losses can
be represented by this cycle, as presented below:

o the volume energy created by hysteresis losses is corresponding to static hysteresis cycle (f<1Hz).

e as the frequency increases, the cycle area increases and the volume energy created by eddy
current losses is corresponding to the difference between the dynamic hysteresis cycle area and the
static one.

r

E.ED [+ X — Wager keop for 10HzZ ||

Mslor loop for TkHz

fa

000 2l 4000 2000 2000 4000 5000 8000

[
H(Am)

Figure 7: Major cycles for different frequencies

4 | :
Proprietary Information of Altair Engineering \ A ta I r



Altair Flux™ 2019.1 User Guide
2 Detail of new features of Flux 2019.1 p.26

Access to computation of iron losses

Iron losses computation can be accessed in 2D and 3D for laminated regions and for the following
applications:

e For modified Bertotti model: Steady state AC magnetic (averaged iron losses computation) and
transient magnetic (averaged or instantaneous iron losses computation)

e For LS model: Transient magnetic only (averaged or instantaneous iron losses computation) in Flux
Advanced mode

5/ Note: * Laminated regions are often used in magnetic circuits of transformers and of some
electric machines in order to reduce Eddy current losses.

Computation of iron losses

The computation box of iron losses can be accessed in the post-processing context via Computation >
Computation of iron losses > Computation of iron losses

The box is as follows:

@' Iron losses computation >
- Computation type
[on regions -||
Definition |, Results |
Laminated face regions IE‘
- Time interval
X choice Parameter name Current value Lirnit rmir Limit max
O BMAX ¢ 1.0
TIME ' 0.002 ¥ 0.017
- Part of cycle described by the time interval
'Full cycle |
~Model for losses
|Model defined in material ~|
A = [ = ][ ® ]

4 | :
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L=

Note: For information, the former iron losses models can be accessed via menu
Computation > Computation of iron losses > Deprecated versions. For more
information on these models, please refer to Deprecated version

Computation type
The Computation type field enables to choose among the following possibilities:

Proprietary Information of Altair Engineering

On regions : enables to compute modified Bertotti or LS iron losses on a selection of laminated
regions. The iron losses model can be defined on the material or in this box via Model for losses
field. The computation gives instant losses and averaged losses on the time interval for a set of
fixed geometric parameters or fixed I/O parameters.

Multi-parametric on regions : enables to compute modified Bertotti or LS iron losses on a
selection of laminated regions. The iron losses model can be defined on the material or in this
box via Model for losses field. The computation gives instantaneous losses for several sets
of geometric parameters or I/O parameters. This computation can be used in optimizations or
efficiency maps.

On point with LS model defined in the material: this option can only be accessed in Advanced
mode, in transient magnetic application. This calculus enables to compute LS iron loss volume
densities on a point in a laminated region. Iron losses model must be defined in the material. The
computation gives instantaneous losses and averaged losses volume densities on the time period
for a set of fixed geometric parameters or I/O parameters. With this computation, it is possible to
display the hysteresis cycle.
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2.2.2 Iron losses model

Introduction
Iron losses model can be defined:
¢ In the material
e In the post-processor, in Iron losses computation box

In both cases, the defined model is only used for the computation in the post-processor. Iron losses are
not taken into account in the solving process.

This part describes both models as well as the definition steps in the material.

Modified Bertotti model

Presentation of the model:

The theory of Bertotti gives us the expression of the magnetic losses depending on the frequency and
the magnetic flux density.

The power density is expressed with transient magnetic relation:

B) -mi B a o
dp = (kl (max( )2m1n( )) Stk g(a) %

2
(27)*" 4lcos* (0) do

03
) Kf With

dB
+ o k3 g(a3) ‘E

g(a)=

where:
e kl: is the coefficient of losses by hysteresis
e Kk2: is the coefficient of classical Foucault currents losses
o Kk3: is the coefficient of supplementary losses or in excess*
e al: is the exponent of losses by hysteresis
e a2: is the exponent of classical Foucault currents losses
e a3: is the exponent of supplementary losses or in excess*
o f: frequency
e B: induction
e Kf : fill factor of the region

* the distinction between supplementary losses / in excess losses and classical losses is artificial. They
can be grouped in one term and they therefore correspond to real induced currents flowing in the sheet.

Note: An Excel sheet permitting to determine, for a sinusoidal magnetic flux density, coefficients and
exponents of Bertotti formulation is available. This tool, as well as its documentation, have been stored
on your space disk, during Flux installation, at the following path :

C:\Program Files\Altair\2019\flux\Flux\DocExamples\Tools\BertottiLossesCoefficients
(If Flux is installed at the path proposed by default (C:\Program Files\Altair\)
Limits of validity

In a Steady state AC Magnetic application, power density is expressed with the following equation:

7y Altair
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1

o a
dP = lemaxf+k2(Bmaxf) 2+k3(Bmaxf) ’

It is important to note that in the previous formula, the Bmax variable stands for the peak value of the
magnetic flux density.

The software utilizes the value of the magnetic flux density in each point. Consequently, it is convenient
to be very careful with the results concerning the problems represented by the rotating machines

with the Steady state AC Magnetic simulation. Indeed, for this type of simulation the rotor has a fixed
position with respect to the stator, and the real rotor movement is modeled by changing the resistivity
of the conductors of the rotor electric circuit. Thus, the calculated magnetic flux density is maximum

in a point on the given position of the rotor in relationship with the stator, due to space harmonics. It
follows that the calculated magnetic flux density does not correspond to the peak value of the magnetic
flux density over a period in the time domain if the rotor were turning. Consequently, the computation
of the magnetic losses must be utilized in this case with much caution.

Moreover, in the case of a non-linear approximation for the magnetic behavior law B(H), the saturation
phenomenon, introduced by means of an equivalent model of magnetization, can alter the local values
of the magnetic flux density.

Steps of the modified Bertotti model definition in the material

The steps of the modified Bertotti model definition in the material are as follows
1. Create material

2. In Iron losses tab, check Model for iron losses computation and choose Modified Bertotti
model

3. Enter coefficients and exponents

LS model (advanced)
CAUTION: This model is only available in Flux advanced mode.

Presentation:

The LS (Loss Surface) model is a method of estimation of the magnetic losses a posteriori, based on a
model of dynamic hysteresis associated to a finite elements simulation. The LS model requires that the
magnetic behavior of a material be perfectly well defined, having knowledge of a characteristic surface
H(B,dB/dt) (determined experimentally). Thus, for a B(t) signal of a certain shape and frequency,

we can go up via the H(B,dB/dt) surface to the H(t) field, and thus reconstruct the dynamic cycle of
hysteresis corresponding to it. This principle is represented below.

e B(t) signal with common form and frequency

e Creation of a characteristic surface H(B, dB/dt) of the material measured experimentally.
e Reconstitution of H(t) signal (i.e. of the hysteresis cycle)

e Calculus of losses

Characteristic surface H(B, dB/dt):

For each of the materials, the characteristic surface H(B,dB/dt) can be obtained by using a Epstein type
device for magnetic measurements in medium frequency.

An example of this type of surface is represented in the figure below.

7y Altair
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Figure 8: H(B, dB/dt) surface

Reconstruction of the cycle:
An analytical model permits the reconstruction of H field from values of B:
H(B,dB/dt) = Hstatic(B) +Hdynamic (B,dB/dt)

B(H) curves like those in the figure below can therefore be obtained, permitting the computations of
iron losses quite accurately.

16
1.2
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0.4

-1.2

-1.6
~1800 =1200 -600 0 GO0 1200 1800

H (A/Im) ——Estimated - %- Measured

Figure 9: Sinusoidal magnetic flux density & 5th harmonic at 200Hz
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The LS model is assigned to different nuances of laminations, which have been especially described to
this purpose.

Available materials:

These are (by the international nomenclature IEC 60404-8-4-1998):
e M330-35A
e M800-50A

Iron sheet characteristic:

Magnetic polarization at saturation (Jsin T) = 2.03T

Volume density (kg/m3) = 7650 kg/m3

If you will wish to add a new material, get in touch with Altair and the G2ELAB (Laboratoire de génie
électrique de Grenoble); you should expect a minimum delay of approximately six months.

It is also possible to contact Spin (https://www.spinmag.it/); you should expect a delay of one month
approximatively.

Steps of LS model definition in the material
The steps of LS model definition in the material are as follows:
1. Launch command with Physics > Material > Create an LS material
2. Choose definition of LS model:
e Select iron sheet
e Select a .mils file
3. Enter the following option:
e Selection of anhysteretic curve / first magnetization
e Selection of replace existing material / create a new material

Note:

¢ Additional information on iron loss with LS model is available in the following document:
« Module LS pour l'estimation des pertes fer dans les machines électriques » - A.
Lebouc - Rapport d’étude mai 2004

4 | :
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2.2.3 Iron losses computation on regions

Iron losses computation on regions enables to compute modified Bertotti or LS iron losses on a selection
of laminated regions. The iron losses model can be defined on the material or in the iron losses
computation box in post-processing. The computation gives instantaneous losses and averaged losses
over a period for a set of fixed geometric parameters or fixed I/O parameters

Steps for iron losses computation on regions

This section describes the steps to carry out iron losses computation on regions:

@' [ren losses computation >
- Computation type
|on regions -|
Definition | Results '
Laminated face regions IE
-Time interval
¥ choice Parameter name Current value Lirmit miry Limit max
I EMAX v 1.0
TIME ¢ 0.002 |¢ 0.017
-Part of cycle described by the time interval
| Full cycle '|
-Model for losses
|Mnde| defined in material '|
L:g oK Cancel H ih)

1. Choose a Computation type: On regions
2. Select laminated regions for iron losses computation
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3. Choose:

e Fix values for geometric parameters and I/O parameters

¢ In transient magnetic: time interval to obtain a time period. This choice is linked with the field
Part of cycle described by the time interval

4. In Transient magnetic, define the time period selected in the previous step. The various
possibilities are presented in the table below:

Choices Description

Full cycle If the period is composed by N time steps,

The user selects time steps i and N+i
(The time steps i and N+i are identical)

Remark: The first two steps of the scenario are hidden as they
cannot be selected for this computation.

Half cycle If the period is composed by 2N time steps,

The user selects time steps i and N+i

(Flux reconstitutes the electrical period which comprises 2N+i time
steps. The time steps i and 2N+i are identical)

Pair symmetry f(T/2+t) = - f(t)

A

Note: Half cycle option can manage a signal with a DC
component.

[

No cycle Flux does not take into consideration the period.

5. Choose losses model:
¢ Model defined in material
o Modified Bertotti: Enter the coefficients values and modify exponents if necessary
e LS predefined sheets (in transient magnetic, in Advanced mode): Enter the sheet iron
e LS defined by importing of a MILS file (in transient magnetic, in Advanced mode)
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Results of iron losses computation on regions

Computation results
The computation of iron losses on regions gives the following results

'@ Iron losses computation >
- Computation type
|Un regions '|

Definition " Results |
Result curve name *
| CURVE_LOSS _REGION_1 |
Result name *
|LGSSES_IN_REGIDN_1 |
Spatial quantity name for the average loss density *
| DVOL_LOSS_MEAM_1 |

Spatial quantity name for energy density *
|DVOL_ENERGY_LOSS_1) |

Curve

"CURVE_LOSS_REGION_i" curve can be displayed automatically and is stored in the tree in the area
Postprocessing > Curve > 2D curve (I/0 Parameter).

It represents instantaneous losses on the region(s) versus time.

Result

The results are automatically displayed in the data tree in the area Postprocessing > Result > Iron
losses Result.

The results include:
e Average losses over a period on region(s) (in W)
e Iron losses energy on region(s) (in J)

Spatial quantities
Spatial quantities, denominated "DVOL_ENERGY_LOSS_i" and "DVOL_LOSS_MEAN_ i" are stored in the
data tree in the area Parameter/Quantity > Spatial quantity
Spatial quantities correspond to:
e Average loss density "DVOL_LOSS_MEAN_i”
e Losses energy density "DVOL_ENERGY_LOSS_i"

Display loss density (isovalues)
It is possible to display the above mentioned spatial quantities in a color shade graphic (isovalues).
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For this:

¢ In Graphic menu:

Point on Isovalues and click on New
e In the box:
o Choose a support (laminated regions for iron losses computation)
- In the spatial quantities area, open the formula editor... (click on f())
+ In the Editor of formula and spatial quantities box / User tab, select one of the following
spatial quantities:
o DVOL_LOSS_MEAN_i
o DVOL_ENERGY_LOSS_ i
e Confirm by clicking OK

Isovalues are computed and displayed on the selected support in the graphic windows.

7y Altair
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2.2.4 Iron losses multiparametric computation

p.36

Iron losses multiparametric computation enables to compute modified Bertotti iron losses or LS iron
losses on a selection of laminated regions. The iron losses model can be defined on the material or in
the iron losses computation box in post-processing. The computation gives instantaneous losses for
several sets of geometric parameters or I/O parameters.

Steps for iron losses multiparametric computation

This section describes the steps to carry out multiparametric computation for iron losses:

'@ Iron losses computation

Pt

- Computation type

|Mu|tiparametri|: an regions

- |

Definition |, Results '

Laminated face regions

2]

-Intervals of parameters

X choice Parameter name Current value Limit mir Limnit max
ID_FILCT v -250.0 | 0.0
IQ PILCT v 0.0 v 250.0
SPEED #" 545,455 |¢ 5000.0
ANGPOS_ROTOR v 44357 |¢ 39.957

-Part of cycle described by the time interval

|Fu|| cycle

-Model for losses

|Mnde| defined in material

1. Choose a Computation type: Multi-parametric on regions

Select laminated regions for iron losses computation

3. Choose:

e Intervals of values for geometric parameters and I/O parameters after having checked the

corresponding boxes (or fixed parameters values)

e In transient magnetic: time interval to obtain a time period. This choice is linked with the field
Part of cycle described by the time interval

4. In Transient magnetic, define the time period select in the previous step. The various possibilities

are presented in the table of page: Steps for iron losses computation on regions

Proprietary Information of Altair Engineering
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5. Choose the model for losses :
¢ Model defined in material
* Modified Bertotti: Enter the coefficient values and modify exponents if necessary.
e LS predefined sheets (in transient magnetic, in Advanced mode): Enter the sheet iron
e LS defined by importing a MILS file (in transient magnetic, in Advanced mode)

Results of iron losses multiparametric computation

Computation results
The multiparametric computation of iron losses gives the following results

@ Iren losses computation *
Computation type
|r-.-1ultiparametri|: an regions '|

Definition = Results "ln

Mame of the /O parameter to store the instantaneous iron losses
|In5t_irnn_|nsses_1| |

I/0 Parameters

I/O Parameters called "Inst_iron_losses_i" is stored in the tree, in the area Parameter/Quantity >
Parameter I/0

It represents instantaneous losses on the region(s) versus time, geometric and I/O parameters.

Post-processing iron losses

It is possible to use the previous I/O parameter in order to display iron losses computation.

For instance, it is possible to display a 3D curve of iron losses versus two parameters (time or geometric
parameter or I/O parameter) via menu Curve > 3D curve (2 I/0 parameters) > New 3D curve

(2 I/0 parameters). I/O Parameter called "Inst_iron_losses_i" and containing loss values can be
accessed in formula editor (Click on "f()").

Export iron losses

It is possible to export iron loss values via menu Data exchange > Export quantity > Export data
table :
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@' Export a data table

.

Data to expart (output parameters) IE
INST IROM LOSSES 1 -|

~ Export format
| cav file format - |

Filename *
|Irnn_|nsses || .‘!|

-lnput parameters

X choice Parameter name Current value Limit min Limit manx
ID_PILCT ' -250.0 [#f 0.0
IQ_PILOT v’ 0.0 v 250.0
SPEED ¥ 545.455 ¢ 5000.0
ANGPOS_ROTOR. V' 44997 |¢f 39.297

Type of values to export *

|A\ferage value (on transient interval) -
B oK Cancel H (M

For this:

Select "Inst_iron_losses_i" I/O Parameter that has been created during iron loss computation
Choose export format as well as the name of the file
Select intervals corresponding to computation intervals
Select types of values to be exported. For example:
- Average value (on transient interval). Remark: this is a statistical mean.
o Current value
click on OK

Proprietary Information of Altair Engineering
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2.2.5 LS iron losses computation on point (Advanced)

Iron losses computation on point with LS model defined in the material enables to compute LS iron
losses on a point belonging to a laminated region. Iron losses model must be defined in the material.
The computation gives instantaneous losses volume densities and averaged losses volume densities
over a period for a set of fixed geometric parameters or I/O parameters. This command is the only one
that enables to have B(t) and H(t) on a time period, and to plot an hysteresis cycle.

Caution : LS iron losses computation on point is only available in Flux advanced mode.

Steps of LS iron losses computation on point

This section describes the steps to carry out LS iron losses computation on point:

@' Iron losses computation >
- Computation type
(On point with LS model defined in the material -||
Definition |, Results |
-Paosition

Coordinate system for definition *
| xv1 ~|[»]

Coordinates of the point Formula or Yalue

First coordinate

Second coordinate

- Time interval
X choice Parameter name Current value Lirnit rmir Limit max
O ID_PILOT v 0.0
O I0_PILOT ¢ 250.0
O SPEED ¢ 5000.0
ANGPOS_ROTOR v 44997 | 59.997

-Part of cycle described by the time interval
'Full cycle -

_
)

Al [ et JI| ®

1. Choose a Computation type: On point with LS model defined in the material
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2. Enter the coordinates of the computation point belonging to a laminated region
3. Choose:
o fix values for geometric parameters and I/O parameters

e time interval to obtain a time period. This choice is linked with the field Part of cycle
described by the time interval

4. In Transient magnetic, define the time period selected in the previous step. The various
possibilities are presented in the table of page: Steps for iron losses computation on regions

Results of LS iron losses computation on point

Computation results
The computation of LS iron losses on point gives the following results

@' I[ron losses computation >
Computation type
|On point with LS model defined in the material -|

Definition Results‘l,l

Fesult curve name *
| CURVE_LOSS_POIMT_1 |

Result name *
|LOSSES_ON_POINT_1 |

Curve

"CURVE_LOSS_POINT_i" curve can be displayed automatically and is stored in the tree in the area
Postprocessing > Curve > 2D Curve (I/0 Parameter)

It contains three curves:

e volume density of instantaneous losses on the point versus time "DVOL_LOSS_LS_INST"
e Magnetic flux density on point versus time "BMAG1_LS”
e magnetic field on point versus time "HMAG1_LS"”

Remark: the last two curves show the hysteresis cycle on the considered point.

Result

The results are automatically displayed in the data tree in the area Postprocessing > Result > Iron
losses Result.

The results include:
e Volume density of average iron losses over a period on the point (in W/m3)
¢ Volume density of iron losses energy over a period on the point (in J/m3)
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2.2.6 Deprecated version

Bertotti iron losses

This command is available via menu Computation > Computation of iron losses > Deprecated
version > Bertotti iron losses and enables to compute iron losses with Bertotti model with the
following equation:

od?

MH .
P =Bt /1195 22 B, fﬂc+8.76 ke Bl 17

+k

(MT)(t) k, B fﬁh+0_dz ab
Py Hmax 12 |dt

The user should enter the following parameters:

dt

e coefficients and exponents,

o Information about lamination: fill factor kf, lamination thickness d and information dealing with
lamination direction.

LS iron losses on regions
This command is available via menu Computation > Computation of iron losses > Deprecated
version > LS iron losses on regions.

The user chooses a Type of iron sheet among the proposed list. This menu enables to compute losses
thanks to former LS models of Flux.

LS iron losses at a point

This command is available via menu Computation > Computation of iron losses > Deprecated
version > LS iron losses at a point.

This command is the same as the former one, but the computation is at a point instead of a region.

7y Altair
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2.3 Data Export to HyperView and HyperGraph

Introduction

Export to HyperView enables to view and postprocess Flux results in HyperView or HyperGraph
during or after the solving process. This permits to benefits from HyperView or HyperGraph advanced
postprocessing capacities.

Export function can be accessed by scenario box. This process generates an .h3d file.

[/ Note: The user has also the possibility to export results to HyperView from Flux Import/
Export context after the solving process, even if such export is more dedicated to
multiphysic couplings with OptiStruct, AcuSolve, etc. (Please refer to the "Data Import/
Export Context" chapter for more information). In order to help the user, the two workflows
are compared below:

Export via scenario Export via Import/Export
context
Aimed softwares HyperView / HyperGraph OptiStruct / AcuSolve/ ...
Support Full domain of the project Imported mesh / Flux entities

of the same mechanical set

Global quantity One or several Only one

Scenario step All steps Single step or all steps
selection

Visualization During of after solving process After solving process

Export of .h3d file in Flux
Export function can be accessed via solving box, in HyperView export tab:
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@' Edit Selving Scenaric[SCEMARIO_T] >
Mame of the solving scenario * | SCEMNARIO_1 | Comment |
State of the scenario: & Scenario fully processed [] Parametric distribution

Control of transient state \Conh’ol of parameters \Result storage ' HyperView expcrt\

File name |Export_To_Hyper'u'iew|.h3d | El
r Quantities
Conductivity Formula
Eurrent{dersw denity) B
nergy (volume densi

Lorentz force (volume density)

Magnetic field

Magnetic flux density

Permeahility

Power (volume density)

Resistivity Add
ector potential An

Delete all

B[ o< [| wdy [ cnat | ® |

The steps of the .h3d file export are described below:

1. Chose a name for the .h3d file that will contain the data
2. Chose the quantities to be computed on the device

[/ Note: HyperView export can more or less decrease the speed of the solving process,
depending on the project size.

Import of .h3d file in HyperView

The .h3d file generated in Flux is imported in HyperView via menu: File > Load > Results. Chose the
file to import and click on Apply.

Load model and resulks:

[v Load model I Ikup'xe:-:emples"-.Erushless_lF'M_Tutn:nriaI_ED_Ease?xE:-:pn:nrt_TD_H_I,Iper\fiew.hSd [ Owverday

v Load results I Ikup'xe:-cemples'xErushless_lF'M_Tutu:urial_2D_EaseS"~E:-cpu:urt_TD_Hyper"-.fiew.hSd Eﬁ

Rezult-tath template: Standard j Reader Options... | Apply |

7y Altair
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5/ Note: During solving process, the results are not automatically updated in HyperView. In
order to update them, click again on the previous Apply button.

A few tips are presented below in order to view the results:

e In order to view the results computed by Flux on nodes, Use corner data option must be checked:

Result type: _| Selection:
| B [v][c) ﬂ v | Elements I |
Layers: | v v Resolved in;
|.t'3.na|ysis System J

h g
[V Use corner data
'E}_',=.{:|E'r|'| | 4 |

[T Use tracking svstem
Apply

e In order to visualize movement in HyperView, chose Set Transient Animation Mode via the
following icon:

@-00000 ==0

Limitation
HyperView export is not possible in the following cases:
e Scenario with distribution
e Remeshing during solving process, ie.:
o Geometric parametric scenario
o Adaptive solver

- Compressible mechanical set In such case, the export is realized on the device with the
exception f the region including the compressible mechanical set.

7y Altair
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2.4 Flux - HyperStudy Coupling

Introduction

HyperStudy is a multi-disciplinary design exploration, study, and optimization software for engineers
and designers.

It is interesting to couple it with Flux to leverage the HyperStudy approaches (DOE, Fit, Optimization
and Stochastic) for Flux models design exploration and optimization.

The HyperStudy to Flux connection allows exploring efficiently the design space of any electromagnetic
devices modelled in Flux (motor, actuator, transformer...)

Workflow
The general workflow is:

All variables and

Desian the Generate a link Import the
- file (F2HST) B~ F2HST link file in responses are

device in Flux automatically

from Flux HyperStudy

@ Eftmp/Contactor_HyperStudy_CaselfPastprocessed.FLU - Altair Fluox 2018.1 - Flux2D - Magneto Static

Project  Application Data exchange  Support  Graphic  Curve  Computation  Advanced  Display e e ver ek sesiceen e

® A @ TE solving scenario » i %] % s [P T ICR  [———
Nersudy Oosuy Sevesudy Ouesudy || Memais
3y solve Maj-5 % ewbw T orcoy g Ocfn mdeh Aative Lbel  Vimame  lowerbound  Nominl  UpperBownd  Comment
! As0 D LS00 .. 2000000 ., 300000 ., GEOM
[=1| General data 55 Continue the solving process 4 S 2 A.760 DS0000 ,,, 10000000 ., ZOCDOD ,,, GEOM
(2 Geometry 3 pel " 3 atm 20000000 .. SSU000 .., S00000 ,,. GEOM
-0 Mesh I pelete results D ke . ABETAN U0 o IO e, ITSOD .. GEOM
(3 Physics 2] Solving procass options » H AS0ANG L0000 e MW .. DX ... GEOM
03 Parameter ¢ AfocE OO0 ..o ODHHO .. ABNOHD ... GEOM
£3 sabver [ Adaptive solver options »
03 Post process . N .
“ Mulki physic salving session (existing scenaric . .
£3 Tools Rl 4 (et 2 Active Label Vamame  Expression Value
(3 Extensions Generate component for HyperStudy coupling (for HyperStudy 2019.1 and later! 1 @ BTOOTH MAX  r 1 v1[0]
2 ] BN_AIRGAP_RMS 12 v_2[0]
3 ] COGGING_MAX 2 v 3[0]
4 &) COGGING_MIN 1.4 v_4[0]
7
‘e,
%

From Flux 2019.1, generate the component for HyperStudy coupling:

Solving > Generate component for HyperStudy coupling

[/ Note:
¢ This command Generate component for HyperStudy coupling is compatible with
Flux and HyperStudy 2019.1 and later versions.

e This command Generate component for HyperStudy coupling replaces the previous
command Generate component for GOT-It coupling.

4 | :
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0 Evftrnp/Contactor_HyperStudy_CaseL/Postprocessed FLU - Altair Flux 20191 - Flux2D - Magneto Static

Project  Application Data exchange  Suppork  Graphic  Curve  Computation  Advanced  Display
0@ 2 |d ¥5E solving scenario b
Data Tree By Solve Maj-5
[} General data S Continue the solving process 3
@ Delete results 3
Q_'_'] Solving process options ]
%’ Adaptive solver options 3

“ Mulki physic solving session (existing scenario)

[0 Extensions

o Germerate component For HyperStudy coupling (For HyperStudy 2019.1 and later) I

When selecting this command, the following dialog window is displayed:

0 Generate component for HyperStudy coupling (for HyperStudy 2019.1 and later) @
Component name *

Overwrite camponent if exist

yes

™ no

Directary to save companent

| 2]
Component scenaria

Postprocessing python file

| L

—Available parameters ——
Geometric \Physical \

TCORE

WCOIL

HCOoIL

DEPTH

EPS1

GAP

RIMF_INT

RIMF_EXT

EP52

Component inputs
—— Selected parameters —— m

Add all

—Awvailable parameters ——
Geometric \Physical \Sensor \
TCORE
WCOIL
HCOoIL
DEPTH
EPS1
GAP
RIMF_INT
RIMF_EXT
EP52

Component outputs
—— Selected parameters —— m

Add all

@l o ]|

1. Define the name of the component

For example: 4HST

2. Choose to overwrite the component or not, if already existing
3. Optionally, choose the directory to save the component

If nothing is selected, this directory will be the current working directory
4. Optionally, select a scenario

Proprietary Information of Altair Engineering
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=/ Note: In transient applications, selecting a scenario is mandatory.

5. Optionally, select a postprocessing python file in order to automatically postprocess results

=l Note: In transient applications, it is generally used to manage curves (extract values).
Here is an example of a postprocessing python file:
# Delete previous curves

CurveVariation2D[ALL] .delete ()
CurveSpatial2D[ALL] .delete ()

¥ Load a macro, which allows extracting values from curves and create/update I/0Q parameters to store the wvalues
import os
INSTALL = os.environ["INSTALI

macroFile = INSTALL+"/Ext

loadMacro (fileName=macroFile)

¥ Create curves

JEvolutiveCurve2D (name="'COGGEING",

] evolutivePath=EvolutivePath (parameterSet=[SetParameterXVariable (paramEvol=VariationParameter['TIME'],
limitMin=0.0,
limitMax=25.0)1),

IspatialcCurve (name="EN_ &
path=Path[

formula=['Co

¥ Execute the macro to extract values from the curves and store/update I/C parameters

AnalyseZDCurve (curveZD=CurveZd[’

ZnalyseZDCurve (curveZD=CurveZd['E

6. Select the input parameters:
e Geometric parameters (defined with a numerical value, not a formula)
e Physical parameters: I/O parameters (controlled by a scenario, not a formula)

=/ Note: Only the parameters available for selection are displayed.

HyperStudy will change the values of the selected input parameters (ranges are specified in
HyperStudy) in order to explore the design (for instance, find the optimal values with respect to
specific goals and constraints).

7. Select the output parameters:
e Geometric parameters
e Physical parameters: I/O parameters

e Sensors

=/ Note: Only the parameters available for selection are displayed.

7y Altair
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HyperStudy will recover automatically the results of the selected output parameters.
8. Click on the OK button

The following files are created in the working directory:

o the Flux project (which has been duplicated): *.F2HST.FLU

e the link file (which has been created): *.F2HST

In our example, the component name is 4HST, and in the working directory, the following files are

created:

e 4HST.F2HST.FLU: duplicated Flux project

e 4HST.F2HST: link file

[=] 4HST.F2HST 3 |

1

oo -] ;o e L

[ ST o < S L S o o et i el ot e e
o -1 ;m 0 o o O Wm0 -] m e Lo O

s8]
Lo

-

=

<?¥ml wversion="1.0" encoding="UTF-8"2>

<HW PDD schems="altair pdd" schemaVersion="hstp v 3":>

dl——
COPYRIGHT (o) 1996-2019 Altair Engineering,
Email: hatsuppobtfzaltsir.com
FPhone: +1 (243) 6l4-z400
http:ffwuww. altair. com

——=

<DocumentPropertiess
<Filelate>2019-05-07 16:55:41</Filelate>
<Revision>0.0</Fevision>
<Author></Authors>
<adyatenm-Windows (64 bhits)</Syaten:
<CreatedBy>Flux 2019.0</CreatedBy>

</ DocumentFropertiess

<ConnectionlList>

<Connection>
<ItemList>

Inec.

<Item label="TCORE" name="" usage="input':>

<3tatertrue</Itatex
<Conrent > FEOM-< /S Comtrent >

<ModelParameter>TCORE</ Mode lParameters

<InitialValue>20</InitialValue>
<LowerBound>18</LoverBound:>
<UpperBound=22</UpperBound:>
<DataTyperReal</DataTypex
<DataModerContinuous</atalode>
<LewvellList></Levellist>
<WaluelListrx</Waluelistx
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[=-System

R lEmory
--Parallel compuking
- Graphic mode

Mumerical memory
52 %

Character memory
3 %

GUL memory {+ PEEC solver)
26 %

Syskern mernory
19%
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@ Warning:

The memory values specified manually or by default in the Flux Supervisor options are
written in the rF2HST file when generating the component for HyperStudy from Flux. By
default, HyperStudy will launch Flux with these values.
If these values are unnecessary high, it can limit the multiple Flux launching from
HyperStudy. So, before generating the component, a suggestion is to tune the memory
values to the minimum required to solve your model, in the Flux Supervisor options:
& Options @
[E-General Mamary

--Language

--Recent files 0 Skew = ED PEEC

--File bypes @ ' f? %

--Shortouts U A

~Macros °

IG5 | MiB [ 67360 |MEB

~-Mekwork ports
--Debug 2045 MiB I 128 MiB 1024 MiB 763 MiB
--User mode

[]-Access paths ’ Defaul: values ] ’ Help ]

-User version

Note that if you change the memory values in the Flux Supervisor options, after generating
the component, the new values will not be communicated to HyperStudy.

If you would like to change the memory values after generating the component, you can
do it directly in HyperStudy using the solver arguments for Flux in the Solver Input
Arguments field:

Active Label Warname

1 Model 1 m_1 & Flux

Model Type Resource
EAtmp\Centactor HyperStudy CaselMHSTFZHST |0 hstinputhstp

Salver Input File Solver Execution Script

B Flux{ HstSolver Flux) |-batch -enw MEMSIZCI=2147883643 | @

Salver Input Arguments

7y Altair
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In HyperStudy

(1) Attention: For the first use of HyperStudy with Flux, you need to define the solver
installation path

i.e. on Windows: <Flux installation directory>\flux\Flux\Bin\prg\win64\Flux.exe

(by default <Flux installation directory>=C:\Program Files\Altair\2019 if Flux
2019.1 was installed on Windows with an administrator account),

selecting the menu Edit > Register Solver Script > Add Solver Script button

f Add - Altair HyperStudy™ @ f Register Salver Script - Altair HyperStudy™ = @
Label:  Flux #dd Sokver Seript B3 Remove Solver Seript @ Export
Warname: HstSolver_Flu|

Label Yamame Type Preference

Selact Typs 13| Flux HstSolver Flux & Flux Hyperitudy

> B B> @

Genetic IMationSolve Optistruck Radioss

Xl ke,

Feka whpj Flux FluxMatar
SimLab BPreProc

In HyperStudy, start a new study and create a connection with Flux model:

1. a. To start a new study:
Click on Start > New Study

o Untitled - Altair HyperStudy™

' -
B 2P G B
Mew  Open  Save  Close Browsers  Messages
Study View
]
48 Explorer %g Directory 4 start

Start Recent Studies Help Quick Start Examples
I & I ) 1D Harmonic
| , Mew Study Mo Recent Studies 9 HyperStudy g Becilator
Create a new Study
r Open Study e Hyperiorks é Beam Template

II ‘11 Tutarials é Beverage Can

b. In the Location field, select the directory in which the Flux project *.F2HST.FLU and the link
file *.F2HST are located

7y Altair
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o Add - Bltsir HyperStudy™ 5]

Label: Study_1
Varname: s_1

Lacation

I E:jtmp/Contackar_Hyperstudy_Casel I - K

oK Cancel

The new study is created:

o Study_1- Altair HyperStudy™ 2013

New Open GSave  Close Browsers  Messages
Study Wigw

)
45 Explarer ?:g Directary J Define Models
v Study_1 =

4 N Y- Add Madel B Rremaove Madel o2k Model Resaurces

- E& Nom1

v O Definition Active | Label | Yamame | Model Type Resource SolverInputFile | Solver Execution Script Sokver Input Arguments Comment

() Define Madels

€3 Define Input Variables

) Test Madels

€ Define Qutput Responses
© specifications

@ Eualuate

€ Post-Pracessing
D Report

gy Flease add an item.
= Empty collction,

2. To create a connection with Flux model, there are two possibilities:
e A possibility is:
Click on Directory, and Drag & Drop the F2HST file into the graphical interface.

It creates automatically a Flux model and populates the fields.

e e NP

Mame ) Size Type

v | EMmp\Contactor_HyperStudy_Casel Gz e R
7 sohing.py 177 bites gy File Active | Label | Vamame  Model Type Resource Sohver Input File Sobver Execution Seript Solver Input Arguments
P L solvedFLU File Folder 1 @ Modell 1 & Flu Etmp\Contactor HyperStudy Cose IMHSTRZHST |5 hotinput oty & Flue (HitSobver_Flie)  -bateh
2 scriptpy 158 bytes pyFile
B result File Folder

2 postprocessing.pry 284 bytes py File

2 mainpy 202 Bytes pyFile
. hatudy_lock hst 941bytes Study Lock
| error logtd 0 Bytes gt Fils
7 buildphyspy KB pry File
¥ | buildGeometny FLU File Folder
A buildGeomesh.py 119 bytes py File
» B Settings Folds
¥ L TestCase INLFLU File Folder
o Study_Lhstudy 6 KB Study File
7 Srate Postprocessingpy 360 bytes oy File
P | Postprocessed FLU File Falder
b | PhysicBuiltFLU File Folder
A FlwdD_log.py B78 bytes py File
|| Fluoc2Direportick D bytes |k File
| Fluc2Dreport THE report File
] Flus2D.og.lck 0 bytes 1k File

] Fo2Dlog ZKB |agFile

7y Altair
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e Another possibility is:

Proprietary Information of Altair Engineering

Click on Define Models > Add Model

f Define Models

add Model D Remove Model oin Model Resources

Bctive Label Warnarme todel Type Resource

i. Select Flux
ii. Click on the OK button

o Add - Altair HyperStudy™ (=)
Label: Model 1
Varname: m_1
Select Type
{} 0 & &
Parameterized File Internal Math Spreadsheet HyperMesh
MotionYiew Workbench FEKO Fluzz
™y V ¢
v
FluxMotor Operator SimLab HyperStudy Fit
Laakup E PreProcessar
[o]4 Cancel Apply

i. In the Resource field:

Click on F
Add Model D Remove Model ogn Model Resources
Active Label Warname Model Type Resource Solver..utFile | Sobver.. Script | Solver..uments
1 Model 1 rn_1 B Flux v Ihst_input.hstp & Flux(H.. -batch (7]

ii. Browse the directory and select the F2HST file

» Contactor_HyperStudy_Casel » - | 4,.|

Morn

. _usk

. 4HETFZHET.FLU

. buildGeometry FLU
. PhysicBuilt.FLU

. Postprocessed FLU
o result

. sohsed FLU
TestCase INLFLL

|| AHST.FZHST

Cornrnent

p.52
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3. Whatever the creation option used, once the Flux model has been added:

Click on the Import Variables button (at the bottom right)

Your screen should look like this:

- Study 1
é V= Add Model D Remave Model a’%u Model Resources
v L& Setup
@ Define Models Active  Label  Vamame  Model Type Resource SolverInput File Sohver Execution Script SolverInput Arguments

Define Input Variables
Specifications
Evaluate
O Define Qutput Responses
€3 Post-Processing

) Report

1 Model1 m_1

A Flux DALADITIOPTIMIPMFRG & hstinputhste S Flux 2018 { HstSolver Flux) -batch (2]

I.mpor‘tVar\abIes h Back Mext ‘

Messages =
@) 12 Message: Started Model [ m 1 ), Tmport Verisbles ( pid = 38324 )
) 13 Message: Fimished Model ( m 1 ), Impers Variables ( pid = 353324 )
) 14 Message: Imported variasbles from model ( Model 1 ( m 1] )

Note that if the Flux installation path has
is displayed:

Number of design varizbles [ 7 )

Number of responses tan

not been defined in HyperStudy, the following error message

<- Back Next ‘

% Import Variables

i=| Messages =
[T} 1 Message: Read preference file ( C:
@) 2 Message: Read preference file | d:\dmsvrudievs\Mes documents\HyperCreph\preferences v )
) @ Message: Sevtings location ( C:\Users\dmavrudieva\EppData\Loeal\hltair\HyperStudvSettings.uml )
@) 5 Message: Settings location ( C:\Users\dmsvrudieva\AppDsta\Local\Altair\HyperStudySettings v2017.3.0.17 14¢€
@) ¢ Messags: Logging TIME ( 2013-05-13 14:51:50 ) , Elapsed time ( 01:00:00 )
19 7 Error : Path not provided for solver { Flux 2018 ( HstSolver Flux ) ) used by model ( Medel 1 (m 1) )
@ o Message: Imported varisbles from model ( Medel 1 (m1 ) )
Number of design varisbles ( 7 )
Number of responses (-

in this case, please refer to the Attention

at the beginning of this section In HyperStudy.

For more details regarding HyperStudy use, please refer to HyperStudy user guide.
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2.5 Flux e-Machine Toolbox

p.54

Flux e-Machine Toolboxis a new application in Flux dedicated for Electric Machine. This tool permits
to compute and postprocess results dedicated for e-Machine like efficiency maps. It's a first version. It

is planned to enrich the possibilities of postprocessing in future versions.

Content
This chapter deals with following topics:

Flux e-Machine Toolbox:
Flux e-Machine Toolbox:
Flux e-Machine Toolbox:
Flux e-Machine Toolbox:
Flux e-Machine Toolbox:
Flux e-Machine Toolbox:
Flux e-Machine Toolbox:
Flux e-Machine Toolbox:

About

Coupling component
The application
Input parameters
Tests

Postprocessing
Workflows
Command Line
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2.5.1 Flux e-Machine Toolbox: About

Introduction
Efficiency Map

Torgue (N.m)
Machine efficiency

Speed (rpm)

Starting from the 2019.1 version, Flux has a new tool called Flux e-Machine Toolbox. This coupling is
available in 2D, 3D and Skew for the magnetic transient application.

The aim of Flux e-Machine Toolbox is to characterize the behavior of the machine in the "Torque-Speed"
area and allows to postprocess various quantities in this area.

Input parameters like the maximum phase voltage RMS , the maximum phase current RMS and
the desired Maximum speed of the machine are considered.

Two types of command modes are available: The Maximum Torque Per Volt command mode (MTPV)
and the Maximum Torque Per Amps command mode (MTPA).

Type of machine

In this first version, only one machine is taken into account by Flux e-Machine Toolbox. It is the
Synchronous machine, permanent magnet in three phases (Inner rotor or outer rotor) with "integral
slot-winding" (the stator must have the same number of periodicities as the number of poles pair in the
rotor).

New types of machine will be implemented in next versions.

About losses
Different losses are computed and postprocessed:

e Stator Winding Joule Losses: on each coil conductor
e Rotor Eddy Current Losses: on solid conductor regions (magnet, fret, can,...)

7y Altair
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e Iron losses:

o In 2D and 3D:
Only computed on laminated non-conducting magnetic regions
In Flux, it is advised to choose a material with losses, assigned to these regions (the user
has the choice to use LS or Bertotti model)
If losses are not defined on the material, default Bertotti coefficients are automatically
applied
(K1=151.88 ; K2=0.07 ; K3=1.19 ; A1=2; A2=2 ; A3=1.5)

o In Skew:
Only computed on non-conducting magnetic regions , because the laminated regions do
not exist in Skew
Default Bertotti coefficients are automatically applied after the Flux solving process

(K1=151.88 ; K2=0.07 ; K3=1.19 ; Al=2; A2=2; A3=1.5)

Process
Here is the process of the Flux e-Machine Toolbox coupling:

Step Software Description

1 Flux Preparation of the Flux project:
e standard description: geometry, mesh and physics
¢ specific description: losses, number of poles, circuit information...

Note: A classic workflow is to use FluxMotor to pre-design the
electrical machine and export it in a python srcipt. Then the python
script is run in Flux to obtain a Flux 2D project ready to generate the
coupling component

=

2 Flux Generation of the Flux e-Machine Toolbox coupling component

Note: In the options of the generation of the coupling component,
it is possible to choose to go directly at the Step 5. After the
generation of the coupling component, Flux e-Machine Toolbox is
launched (equal to step 3) and the generated component is directly
opened (equal to step 4)

=

3 Flux Opening of Flux e-Machine Toolbox starting from Flux
Supervisor
4 e-Machine Opening of the Flux e-Machine Toolbox coupling component generated by Flux
Toolbox

7y Altair
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Step Software Description
5 e-Machine Choice of input parameters
Toolbox
6 e-Machine Launching of the simulation
Toolbox

e The solving process of Flux is launched in batch mode

e Once the solving process is done, a postprocessing script is run to build the
performance mapping

7 e-Machine Postprocessing of results
Toolbox

7y Altair
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2.5.2 Flux e-Machine Toolbox: Coupling component

Introduction

To achieve a Flux e-Machine Toolbox coupling, it is necessary to generate a coupling component
from the modeled Flux project previously prepared. There are several prerequisites to respect in the
construction of the Flux project to ensure this coupling.

Preparation of the Flux project
Here are the prerequisites:

e Coupling available only in transient magnetic with 3-Phase circuit.

e [/O parameter piloted by a scenario, called SPEED and used in mechanical set in rotation with
imposed speed.

e [/0O parameter defined by formula, called POS_INI and used in mechanical set in rotation for the
time position t=0s.

e A parameter with geometric type for the definition of the pole number.

¢ No need to define a solving scenario, Flux e-Machine Toolbox will do it automatically when running
a test.

e For the Iron losses computation, it is mandatory to use non conducting laminated magnetic regions
for the Rotor and the Stator (valid for 2D and 3D only).

L=

Note: In Skew, the non conducting laminated magnetic regions are not available. It is
advised to use non conducting magnetic regions.

e For the Iron Losses computation, it is mandatory to define a material with losses model, assigned
to non conducting laminated magnetic regions.

e It is mandatory to define in the application the transient initialization option to initialized by
static computation in order to be able to compute the losses directly on the first period and to
limit the number of steps to compute.

* Only one pole section should be represented (the machine should have integral-slot winding).
Therefore, a periodicity must be defined in order to perform the machine simulation.

Coupling component

The coupling component is necessary to ensure the transfer of information of the Flux project to Flux e-
Machine Toolbox. This component is a file *.FEMT.

To access the generation of the coupling component, click on the menu Solving and click on Generate
component for Flux e-Machine Toolbox coupling:

4 | :
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hWNR

- '
@ Generate compenent for Altair Flux e-Machine... M

L

Component name *

— |

|FEI'-.|'IT_|:nmpunent

Cwerwrite component if exist®

Ino

Save directory (working directory if empty)

Open this component in e-Machine toolbox *

yes

-Motor family

|Synchrnnnus machine

-Type

| Permanent magnet SM-FM

rSubtype

|Inner rotor

-Winding Joule losses

|3—F'hase

Zoil conductor - phase 1*

| COIL_1

Zoil conductor - phase 2%

colL_2

Coil conductor - phase 3%

|coIL_3

- Rotor eddy current losses

|Sensnr

Sensar®

| MAGNET_LOSS

|

Q@ O©®OEOO

®

i
Mumber of poles *
|POLES ~|[»
I | oK | Cancel | i
T )

Overwrite or not the component if it already exists

9

Name of the component saved in a directory Name_of_the_component.FEMT

Save directory of the component (by default it's the current working directory)

Motor family (only one available for the moment, Synchronous machine)
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6. Motor type (only one available for the moment, Permanent magnet SM-PM)
7. Motor Sub-type (Outer rotor or Inner rotor)
8. Information needed to compute stator winding Joule losses
a. Number of phases (3 phases only available for the moment)
b. The coil conductor of each phase
9. Information needed to compute Rotor Eddy current losses

a. Either a previously defined sensor, which computes Eddy current losses on magnet rotor
regions

b. Or the list of regions on which the rotor Eddy current losses must be computed (a sensor will
be created automatically)

c. Or the list of solid conductors on which the rotor Eddy current losses must be computed
10. Number of poles of the electrical machine (a geometric parameter is mandatory)

Generated files
By generating the XXX.FEMT coupling component a XXX.FEMT directory is created in which there are:

e The saved Flux project project.FLU
e A directory tests in which tests run in Flux e-Machine Toolbox will be stored

o A file config.xml that contains all the information needed for the computation of perfomance
mapping of the studied machine

7y Altair

Proprietary Information of Altair Engineering



Altair Flux™ 2019.1 User Guide
2 Detail of new features of Flux 2019.1 p.61

2.5.3 Flux e-Machine Toolbox: The application

Introduction
The application Flux e-Machine Toolbox allows to:

e Launch computations of performance mapping of an electrical machine starting from a coupling
component generated in Flux

e Post-process these maps

Launching of Flux e-Machine Toolbox
2 possibilities to access Flux e-Machine Toolbox application:

e Automatically after the generation of the coupling component (if the option has been chosen). The
application is opened and the generated component is automatically opened

¢ Via the supervisor by clicking on:

I e-Machine

= Toolbox

Environment
Here is the environment of Flux e-Machine Toolbox with an opened component without any test run.

E Flux e-Machine Toolbox - test | (Z) = [E5)
o
( i
v B3 '
I 1
1 !
o [
TEST DATA PERFORMANCE MAPPING SINE WAVE TEST
{ Test Conditions 17 Owerview | & 10 m
1 e e T T R e g — ~f -
=< . B —
I Man. Line Current. rms (A) 200.0
1|| [pesien [ [ | ’
: Settings Inputs \ : Family MACHINE_SYNCHRONOUS ) :“’" P“a;e:""“e' 1) i::}i
. ERMAMENT M ammand Mode
I Torgue - Speed Maps I Tee PERMANENT MAGNET I |maximum speed (rpm) 7500.0
| Sub-Type NNER_ROTOR ) :
(] [ — 1 B Raotor Initial Position Mode Auto
= j E‘\ | No. Phases 3-Phases I B Rotor inkial pesitian (@
| =) N W] Yrodute FlLoczD 2019.1 Transient Magnetic 20 ) il '"""’f posttion {eg) ;
I f ¢ o] | uber of poles POLES 8 \ 0. Come. r°r_J°'Jq °
| 1| Vcouniing component test.FEMT DAbvallet\F1ux2019. WEfficiencyMapvalidat...| :"'EDMP' .ncl s”:i” o sz
| = | |Mechanical Set | | 0. Comp. / Elect. Perio
I ta\_ﬂ_ E\l : 1|Rotating Mechanical Set ROTOR mposed speed 1 SIS"IEMIT’;.:IDETI.- Ic:EIl :,G“
I . | ||Fixed Mechanical Set STATOR Fixed position : hum::ra'cem[:‘. "" | S
umoer of Lores umps|
| A Clrcult | | {
1 }_H\ — || Current Source - Phase 1 (4) _1 (Current source of Phasel
1 I["\ﬂ H\q ! || Current Source - Phase 2 (A) 2 Current source of Phase2 | >
- - 11 e P Phase 3 (A erent source of Phase3 )
1 " || Current Source - Phase 3 (A) 3 [Current source of Phase3
| I} |stranded coi conductar - phase 1 COIL_1 COIL of Phase! |
I =~ ] m 1| | |stranded coil Conductor - phase 2 coiL_2 COIL of Phasez I
| = S ) I} | [stranded coit conductor - Phase 3 coi_3 COIL of Phase3 |
e Losse Rotor Edd: Tl Losses |
(] !
| L 1 : Iron Losses Regions ROTORSTATOR ]
| I 1 Rotor Eddy Current Losses Sensor MAGNET_LOSS i
1
é ; 1
1 ® Inputs
1
| Content [ [
\ 1| 1|Rotor initiat pasition Mode
o o —— 4 Rotor Initial position (deg)
Parameters | |
No. Comp. / Elect. Period
Maximum Speed {rpm)
No. Comp., Tor Speed
No. Comp. for Jd. Jq
‘Command
e Miaw lina Corcant reme (AL -

1. Allow the opening of a coupling component generated via Flux
2. Allow access to online documentation of Flux e-Machine Toolbox
3. Different filters for the display of the central zone (all filters are active once a test is done)
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4. Display initial conditions which match the information in the configuration file of the coupling
component

5. Display input parameters, chosen by the user, of the displayed test (empty if no test achieved)
6. Input parameters that the user must choose before running the test by clicking on:

>

7. Access on About box by clickin on the icon:

About Flux e-Machine Toolbox

Flux e-Machine Toolbox

2019.1

r / H
Version 2019.1.0.122 20190612 v Altair
Copyright © 1983 - 2019 Altair Engineering, Inc.

5/ Note: The Overview tab corresponds to general information on the Flux e-Machine Toolbox
application. This tab is independent of the opened component and independent of tests
done.

-E Flux e-Machine Toolbox - TEST B @ X
TEST DATA PERFORMANCE MAPPING SINE WAVE TEST
@ @ PARAMETERS
Max. Line Current, rms (A) 1200.0
Settings Inputs. Max. Phase Voltage, rms (V) 1220.0

Machine behavior in torque-speed area

command Mode MTPA
Maximum Speed (rpm) 7500.0

Torque - Speed Maps

@ Openthe Rot osition Mode Auto
@ @ ouping compore Rotor initial position (deg)

E B generated in Flux No. Comp. for Jd. Ja 10
Efficiency Curen X L\:‘:' No. Comp. for Speed 15
Postprocess 7 No. Comp. / Elect. Period 50
@ m . Per';wm ol : T [@enterthe user Distribution (local - CDE) No

haps 3 ; input parameters Numerical Memory (Vi) 192

Control angle i [Number of Cores (Mumps) i

RN
2 8 N
N

@ About Losses?

Q Stator Winding Joule Losses: on each coil conductor

Joule Losses Rotor El“"’ Current Q Rotor Eddy Current Losses: on solid conductor regions (magnet, fret, can,...)
osses
Q fron Losses:
o In 2D and 3D
= Only computed on laminated no-conducting regions

= InFlux itis advised to choose a material with losses, assigned to
these regions (the user have the choice to use LS or Bertotti model) &
« If losses are not defined on the material, default Bertotti coefficients
are automatically applied
o InSkew:
= Only computed on magnetic no-conducting regions
= Default Bertotti coefficients are automatically applied after the Flux
solving process
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2.5.4 Flux e-Machine Toolbox: Input parameters

Introduction
After having opened the coupling component in Flux, the user must define several input parameters
befor running a test. These parameters allow to:

¢ pilot the solving of the Flux project

e specify solving options (distribution, memory)

e compute and build the different performance maps

PARAMETERS
Max. Phase Current, rms (&) 200.0
Max. Phase Voltage, rms (V) 220.0
Command Mode MTPA
Maximum Speed (rpm) 7 500.0
Rotor Initial Position Mode Auto
Rotor initial position (deg)
No. Comp. for |d, g 8
No. Comp. for Speed 10
No. Comp. / Elect. Period 30
Distribution (local - CDE) Yes
Numerical Memory (MiB) 8192
No. Cores (Mumps) 1

I

Input parameters : Wished data
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e Maximum phase current RMS
e Maximum phase voltage RMS
e Command mode:
o either MTPV: the Maximum Torque Per Volt
o either MPTA : the Maximum Torque Per Amper
¢ Maximum allowed rotating speed for the electrical machine

Input parameters: Rotor initial angle
The Rotor initial angle is a necessary variable in order to apply Park’s transforms. Two possibilities:

e User: the user knows the initial angle of the rotor and can enter the value

e Auto: the value of the initial angle of the rotor is computed automatically. The goal is to find the
rotor angle for t=0s in order to align it with the magnetic flux density in the airgap generated by
the reference phase (e.g., phase A). Two simulations are performed in order to compute rotor initial
angle. A path in the middle of the airgap is automatically defined in order to compute the magnetic
flux density within it.

Input parameters: Number of computations requested
e Number of computation for Jd and Jq (8 by default)
e Number of computations for the speed (10 by default)
¢ Number of computations by electrical period (30 by default)

5/ Note: The total number of computations is the product of the 4, so with the default values
there are 19200 computation points. It is necessary to have enough points to obtain a good
Torque-Speed envelope. So the calculation time can therefore be quite long. The choice of
values is a compromise between accuracy of results and solving time. The default values
allow this compromise.

As a reference, for 20000 computation points on a server with 22 cores with 8 Mio (GB)
of numerical memory, a 2D project is solved in 5h. With this same project, with 75000
computation points (Id and Iq at 10, Speed at 15 and Nb of computations by electrical
period at 50), results will be more accurate but with a solving time around 24h.

Input parameters: Options of distribution and memory

e Activate or not the local distribution CDE (Computing Distribution Engine). The number of cores
must be defined in the configuration of CDE

] Attention: Make sure the service is installed and enabled. If this is not the case even
with the option to Yes, the solving will be sequential and not distributed.

=l Note: The computing distribution is not implemented in Skew.

e Numerical memory allocated to the solving of Flux project
¢ Number of cores used by the Mumps solver for the initial project
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o If the local distribution via CDE is Yes, the value of the number of cores used by the Mumps
solver is fixed at 1, and non accessible for the user, (in this case the parameter is grayed out,
which means that the indicated value is not taken into account)

o If the local distribution via CDE is No, the user value of the number of cores is taken into
account by the Mumps solver. By default this value is 4.

- In the case where the local distribution via CDE is Yes, but CDE is not correctly configured, the
number of cores entered will be taken into account by the Mumps solver.
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2.5.5 Flux e-Machine Toolbox: Tests

Running a test

Once the input parameters have been defined, the user can run a test by clicking on IZ'

V .

A dialog box appears in which the user must choose the name of the test and click on

MName

[Test |

List of tests

Once the test running is done, the test appears at the bottom right. Several tests can be run on a same
component, in this case they are listed:

TESTS = | [

v test] 2019-06-11 01:56:15
X test2 2019-06-11 01:56:44
3. test3 2019-06-11 01:57:00

Actions on a test
The possible actions on a test run are:

+ Display:
Display the test results by double-clicking on it or by right click — Display

A tab with the name of the test is added in the central area, and it is possible to navigate easily
using the filters on the left

e Close:

Close the display of a test by clicking on the cross of the tab or by right-click A Overview or
by right-click — Close

o Delete:

Delete a test by selecting it in the list and by clicking on |]I| or by a right-click — Delete

e Export:

Export a test by selecting it in the list and by clicking on E or by a right-click — Export
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Test states
A test can have 3 states:

v . the test is successful

* 3. : the test is in progress

x : the test is failed

Export a test
A test can be exported in 3 different formats:

o pdf format for a report (equivalent to all the content of the central area)
o html format for a report (equivalent to all the content of the central area)
o txt format to postprocess data (a text file by quantity)

Format
[paf §|

Destination directory

[Do\bvallet\Flux2019.1\EfficiencyMap\Validation\CAS R... | (D)

Name
[Test1_export] |

4 | :
Proprietary Information of Altair Engineering \ A ta I r



Altair Flux™ 2019.1 User Guide
2 Detail of new features of Flux 2019.1 p.68

2.5.6 Flux e-Machine Toolbox: Postprocessing

Introduction

Once the test running is completed, performance maps are displayed in the central area. The filters
on the left allow to display directly the perfomance map wished. The user has the possibility to use a
cursor to display values by pointing on the map.

Flux e-Machine Toolbox - TestFemt = x]
TEST DATA PERFORMANCE MAPPING SINE WAVE TEST
Test Conditions 1 Overview [1l-al <
@ @ Efficiency in Torque-Speed Area 1 PARAMETERS
Max. Line Current, rms (A) 200.0
Settings Inputs 2.803E-1 Max. Phase Voltage. rms (V) 220.0
150 Command Mode MTPA
Torque - Speed Maps 0.0886-1 — Maximum Speed (rpm) 7 500.0
Rotor Initial Position Mode Auto
@ @ 8374E1] — Rotor initial position (deg)
Effici C t R No. Comp. for Jd. Jg 10
ileney urren 765061 — No. Comp. for Speed 15
No. Comp. / Elect. Period E)
@ B 694561 o Distribution (local - CDE) No
E 5 Numerical Memory (MiB) 8192
voltage Control angle Z 6.230E-1 S Number of Cores (Mumps) 1
a
S =
5 : > ]
Power Iron Losses 2
430161 B4 =
50
4.087E-1
Joule Losses Rotor Eddy Current
Losses 337261
5
@ 2657E1
’ e
Total losses ) 52 : 184361

[} 1000 2000 3000 4000 5000 6000 7000

Speed (rpm)

Current in Torque-Speed Area

e\ Y

Performance maps
Several quantities are postprocessed in the Torque-Speed area:

e Efficiency

e Phase current

e Phase voltage

e Control angle

e Mechanical power

e Iron losses in rotor and stator

e Stator winding Joule losses

e Rotor Eddy current losses

o Total losses: the sum of these 3 types of losses
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Skew specificity

In Flux, the description of a Skew model is done in the 2D environment. The 3D device is then rebuilt
for the postprocessing. The face regions become volume regions.

The iron losses are only calculated on the non-conductive magnetic regions, because the laminated

regions do not exist in Skew. In this case, the default Bertotti coefficients are applied after the end of
the Flux solving process.

(K1=151.88 ; K2=0.07 ; K3=1.19 ; A1=2; A2=2; A3=1.5)
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2.5.7 Flux e-Machine Toolbox: Workflows

Generate a coupling component for Flux e-Machine Toolbox
Here are the steps to run a computation via Flux e-Machine Toolbox:
1. Open the project in Flux starting from the Flux Supervisor

— The description of the electrical machine is considered done in this project

N

Check the prerequisites in the Flux project for Flux e-Machine Toolbox coupling

w

Open the dialog box of the generation of Flux e-Machine Toolbox coupling component

Click on the Solving menu and click on Generate component for Flux e-Machine Toolbox
coupling

Choose the name of the component

4
5. Choose to overwrite Yes or No the component if already existing (No by default)
6. Choose the save directory (the working directory by default)

7

Choose to run Yes or No the Flux e-Machine Toolbox application and open the generated
component (Yes by default)

8. Choose the electrical machine to study (family, type and sub-type of the motor)
9. Choose the prerequisites for the computation of stator winding Joule losses

a. The number of phases

b. The coil conductor for each phase
10. Choose the prerequisites for the computation of rotor Eddy current losses

a. Choose the support type (Sensor or Region or Solid conductor)

b. Choose the support
11. Choose the geometric parameter defining the number of poles of the machine
12. validate by clicking on OK

— The coupling component XXX.FEMT has been created

— Flux e-Machine Toolbox is launched and the coupling component is opened

Run a test in Flux e-Machine Toolbox
Here are the steps to run a test in Flux e-Machine Toolbox:

[/ Note: The coupling component is considered already generated in Flux.
1. Open Flux e-Machine Toolbox by clicking in the supervisor on:
I\ e-Machine
! = Toolbox

2. Open the coupling component by clicking on the icon:

D and choose the coupling component XXX.FEMT and validate
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— The component is opened in Flux e-Machine Toolbox
3. Define different user parameters
4. Run the test

Click on IZ'

— A progress bar indicates that the test is in progress

Computing test "Test1" [ |

— The Flux solving is run in batch mode
— Once the Flux solving is done, a postprocessing script is run
— Once the postprocessing script is completed, perfomance maps are loaded in the central area of
Flux e-Machine Toolbox
5. Postprocess the maps

— It is possible to export the results of a test for a report (HTML and PDF format) or to
postprocess data (TXT format)

Variant: Run a test from an electrical machine model obtained by FluxMotor
It is possible to do a Flux e-Machine Toolbox coupling from a motor described in FluxMotor and thus
benefit from the pre-design done with FluxMotor and the modeling of the losses in Flux to obtain the
performance maps in Flux e-Machine Toolbox:
1. In FluxMotor, generate a python script corresponding to the studied motor
2. In Flux:
a. Run this python script to create the Flux project
b. Save the project
c. Generate the Flux e-Machine Toolbox coupling component
3. In Flux e-Machine Toolbox, run the test

7y Altair

Proprietary Information of Altair Engineering



Altair Flux™ 2019.1 User Guide
2 Detail of new features of Flux 2019.1 p.72

2.5.8 Flux e-Machine Toolbox: Command Line

Introduction

The command line of Flux e-Machine Toolbox is a program called emtcl1i which allows to invoke certain
features of Flux e-Machine Toolbox from a script.

This command line can be launched from the emtcli.exe file located in the directory:
%FLUX_INSTALL_DIR%/Flux/EMachineToolbox/bin

Currently emtcli allows to run an performance map computation from an existing Flux e-Machine
Toolbox component and / or to export the results of a previous perfomance test.

The different syntaxes
e Running an performance map computation:

emtcli --project <FeMT component path> --inputs <input file path>
e Export results of an existng computation in txt format:

emtcli —--project <FeMT component path> --export <test name> <format> <output path>
e Running a computation and export it at the end:

emtcli --project <FeMT component path> --inputs <input file path> --export <test
name> <format> <output path>

Options
e —-project: the path of the Flux e-Machine Toolbox coupling component from which the
computation or the export must be run

e —-inputs: the path to the text file which contains the input parameters of the computation to run.
This file must contain one parameter by line, each parameter being defined by: Name=value.
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The supported parameters correspond to the input parameters displayed in the Flux e-Machine
Toolbox application and are described below:

TestName=<Name of the test to create to do a computation>
LineCurrent=<corresponds to the RMS phase current maximal (A)>
LineVoltage=<corresponds to the RMS phase voltage maximal (V)>
CommandMode=MTPA or MTPV <corresponds to the command mode>
MaxSpeed=<corresponds to the maximal speed (tr/min)>

InitialAngleComputation=USER or AUTO <corresponds tothe definition of the initial
angle>

InitialAngle=<corresponds to the rotor intial angle (deg, to define only if
InitialAngleComputation is fied at AUTO>

p.73

NbIdIg=<corresponds to the number of computation for Jd, Jg>

NbSpeed=<corresponds to the number of computation for the speed>

NbCompElectPeriod=<corresponds to the computation by electrical period>

DistributionEnabled=yes or no <corresponds to the distribution (local - CDE)

CoreNumber=1 <corresponds to the number of cores (Mumps)>

NumericalMemory=2048 <corresponds tot the numerical memory (Mio) >

-—export: must be followed by exactly three arguments:

o

<test name>: The name of the test present in the coupling component, for which the results
must be exported. The name will also be used to name the export directory in which the text
files will be exported

<format>: The format of exported files. Currently only the string "TXT" is supported and allows
to export the results in text format

<output path>: The path of a directory in which the export directory will be created. If this
path does not point to an existing directory the command line will try to create the missing
directories

Example of use via the DOS console

It is necessary to have generated a FeMT coupling component from a Flux project and have the path to
this component. For instance d:\Example emtcli\Example.FEMT. Here are the steps to use the command
line via DOS:
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1. In a user working directory, create a new text file named « inputs.txt »

inputs.txt - Bloc-notes

D) » Bample emtcl v-+? Rechercher dans : Exa e emic 2
Fichier Edition Format  Affichage
ir - Imprimer Graver Nowveauw dossier = v M 7] TestName=EMTC TiExample
u InitialangleComputation=AUTO
*  Nem Medifié le Type (Ml NEIdIq=10
I Maxspeed=73500.0
: 206,/ 2015 1 218 Deculllll NoSpeed=15
inputs.bd LU S01A L AL LACCL
: - Maxangle=90.0
Ourwrir | NbCompE lectPeriod=40
I ' commandMode=MTev
03 RORES |LineCurrent=200.0
Modifier Linevoltage=220.0

pistributionEnabled=no
CoreNumber=1
NumericalMemory=2048

fi Déplacer vers OneDrive
T-Zip k
B CRC SHA ¥
I Edit with Motepad++

Copier le nom du fichier [
Quvrir avec I k /| Bloc-notes |
. I nik

p.74

2. Open the « inputs.txt » file in a text editor and enter wished values for input parameters of test to

run:

l Examiple emich II
Twtir

Dunvar dand uneg anaells Pendtng

i, Tous droite rdzerwds,

Browe with Winlvs

WinDarbtat
1-Tip 0
CRC SHA ¥

F Agent Rangack

Partager svec 4
-
7 Rechercher les menaces

Restaurer s versions précédenbes

Ouvrir une fendtre DOS

Fvhure dang.

Pt v
oG thqu

B Scan with Malwaebytes fnti-Mabsae

3. From a Windows Explorer, open a DOS window in the working directory

4. In the DOS window, update the environment variable « Path » by adding the directory « bin » of

EMachineToolkit to be able to run easily emtcli:
> setPATHZSPATH%;C:\Altair\Flux72Ol9.l\EMachineToolbox\bin

5. Then execute the command « emtcli » to run the test and export results:

> emtcli --project Example.FEMT --inputs inputs.txt —export EMTCliExample TXT

“d:\Example emtcli”
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